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1

Introduction

This document outlines the major changes and new features relating to CAS products based on
CAS genesisWorld. Please note, this information is based on changes made since the initial
release of version x6.0.0. This document will be updated for each software update version x5 to
provide you with a chronological overview.
Customer-driven product changes taken from support feedback are described in the readme
files that are included in every software update.
The  symbol marks ideas that have been submitted by partners and are now implemented in
the program.
All software updates are cumulative, which means that any changes made in earlier updates are
always included in the latest update.

2

Version x7.0.0

2.1

Updated instructions

User Guide Duplicate Finder pro

2.2

Updated releases

Citrix 7.6

2.3

Discontinuation announcement

The following functions are no longer available as of version x7 of CAS genesisWorld. Exceptions
relating to existing installations will be communicated separately.
Exchange connect
The Exchange connect add-on module will no longer be available with CAS genesisWorld x7,
instead Exchange sync will replace it. Existing customers who have an active update service
contract can migrate from Exchange connect to Exchange sync free of charge.
Timeclient online portal as a component of Project, Helpdesk and Timeclient online
The Timeclient online portal will no longer be included. Suitable functions will be replaced by
CAS genesisWorld Web.

Web access portal
The Web access portal has been discontinued since the CAS genesisWorld x6 version,
however, as of CAS genesisWorld x7, it will no longer be available for existing installations.
Microsoft Office 2007
CAS genesisWorld x7 cannot be released in conjunction with Microsoft Office 2007.
Importing and exporting appointments in the vCal format
Appointments in the vCal format can no longer be exported or imported in the Windows
Client.
Cockpit elements for Microsoft Outlook data
You will no longer be able to create cockpit elements for Microsoft Outlook content such as
Outlook - All tasks, Outlook - Upcoming appointments, Outlook - E-mails today. Existing
elements for Microsoft Outlook are no longer displayed on dashboards.
Symbian for Mobile sync
Mobile sync (based on CAS genesisWorld x7) cannot be released for the Symbian operating
system.
Creating tasks automatically in Holiday administration
Tasks are no longer created automatically when creating a new holiday entry in Holiday
administration in teamWorks.
Apache 2.0
The Apache 2.0 Webserver for Web solutions cannot be released for CAS genesisWorld x7.
Total and Contribution margin fields for projects using the Project add-on module
The Total and Contribution margin fields have been displayed in lists up until now.
However, as of CAS genesisWorld x7 both of these fields will be discontinued.
Anniversaries and Fix days in working hours
In the Working hours settings for the CAS genesisWorld Windows Client, working hours can
no longer be set for an anniversary or Fixed day.
Convert archive file function
In the Tools menu, the function for converting archive files from older Office formats, for
example, from DOC into DOCX is no longer available.
Starting another CAS genesisWorld
As of version x7, you can no longer start another instance of CAS genesisWorld from the
Tools menu.

2.4

New functions in the Management Console

2.4.1

Notification with a link to the CAS genesisWorld Web

A new action field is now available in the notification and action service: Link to CAS
genesisWorld Web. The field's functionality is similar to that of the Link to CAS teamWorks
action field and inserts a data record link into CAS genesisWorld Web.
In the Management Console > Rules > Server settings you have to enter a suitable URL for
CAS genesisWorld Web.

2.4.2

Linking archived e-mails automatically

You can set rules for e-mails that you want to archive and also link these rules to archived
e-mails automatically.
With this rule, specific data record types and specific fields of this data record type are selected.
The system checks e-mails that you want to archive, to determine whether a specific pattern can
be detected in the Subject line. If a specific patters is detected in the Subject line and also a
field value for a specific data record, then the data record and the archived e-mail are linked.
Your administrator sets the rules in the Management Console.
Open the Miscellaneous area > E-mail > Archived e-mail.
You will see a list of existing rules displayed in the Link archived e-mails area.
Selecting either New or Edit opens the Edit rule window.
You define the type of data record you want to link in Data record type.
The frame is defined as the Special character that appears in the Subject line of the
e-mail and which contains the Prefix and the Field value.
The Prefix is a random string that occurs before the Field value.
Field is the data record type field and Field value, which is checked in the e-mail Subject
line.
The preview displays the pattern or order which has to be reflected in the e-mail subject
line. A link is inserted for archived e-mails which conform to this pattern.

Important information
A space is inserted between the prefix and the field.
The creation of an automatic link is not displayed in the CAS genesisWorld archiving wizard
for users, this is because, this is set automatically after archiving.
If multiple data records are found, then multiple links are created. When using the Premium
Edition, primary links are entered if possible.
You can create any number of rules with respect to linking archived e-mails and data records
for each data record type.
If you use Helpdesk, you can create e-mails from tickets using a template. You can configure
the template so that data from the ticket, such as the ticket number, is transferred to the
Subject line of the e-mail. If you want to archive such an e-mail and a suitable rule is available
then the archived e-mail is linked with the ticket.
It is only possible to create a common e-mail, which is not a CAS genesisWorld data record,
from a data record that includes fields which have been transferred from a data record with
tickets.

2.5

2.5.1

New Functions in CAS genesisWorld Desktop

Select participants with ease

The Participants field and the Select participants window have been fully revised and their
functionality extended.

The following changes have been made to the selecting participants process:
Participants and resources are always selected in a field and displayed. The resources field has
been removed.
The system will suggest usernames, groups and resources while you are typing. Pressing enter
accepts the suggestion.
You can remove participants, groups and resources that you have already added by simply
clicking the x button. The button is displayed when a user places their cursor over an entry.

As was previously the case, your administrator can configure the Participants field to be
available directly on the General tab for specific data record types, this is done in
Participants/Resources in the Miscellaneous area of the Management Console.
Selecting the Compact layout displays user data with a place holding photo icon instead of
their photo.

Important
To display an address image, you should ensure that the Employee data tab is available in user
addresses. You will find more information on this in the Online Help for users document
Employee data records.
You can also select whether you want the Participants field to be displayed in normal or
compact layout format for the Participants/Resources field in the Form Designer.
If addresses in CAS genesisWorld have been allocated to users making the Employee data tab
available, then direct calls or e-mails are possible. Contact options are displayed in the
mouse-over functions, when a user places their cursor over a name.
More information is now available for the appointments data record type:
If you can see green and red highlights on the left-hand edge when making a user entry, then
this indicates whether the colleague or resource has already been committed for the
respective time slot.
Please note that you will only be able to see availability if SmartSearch has been activated.
Green: indicates that the user or resource is available for the time slot and that there are no
conflicts in the form of overlaps or holidays.
Red: indicates that there is a conflict with the user or resource during the time slot you
selected, this could be either an overlap or holiday.
Thus, you can see at a glance whether, for example, a meeting room is vacant for the time slot
you envisaged.
Below the contact options in the mouse-over functions you will see the user or resources
overlaps displayed.
Users who have their birthday on the same day as the appointment, will have a balloon
icon displayed next to their photo.
If any invitees have already responded to the invitation then their responses are displayed
in the bottom right-hand corner.
The Select participants window has also been revised and its functionality has been extended.
The tab for favorites, users and resources in the link list has been removed. There are three
buttons you can use to filter the list in the bottom left-hand corner: All, User, Resources.

Any favorites you have saved, are displayed automatically at the top of a list. Users can add
users to their favorites by clicking the star icon after a user's name. Clicking the star icon again
removes them.
We have removed the function for defining favorites on the Working environment tab in the
Settings window.

2.5.2

Miscellaneous

SmartSearch now includes opportunities, holidays and phone calls. For this the following
fields have now been included in the search index:
Opportunity

keywords and customer

Phone call

Key words and address quick
info

Holiday

Subject

As usual, there are different actions available for these data record types in the SmartSearch
hit list.
In the inbox, you will see an icon displayed next to an e-mail attachment in GBT format, this
enables you to tell at a glance what type of data record type the attachment is, for example, a
document or a task.
A calendar preview is displayed for every appointment notification.

Saved user e-mail addresses cannot be changed by the user. The settings for this have been
removed from the Settings window on the General tab for e-mail accounts. User e-mail
addresses saved in the database can only be defined and changed by your administrator in
the Management Console.
Customized country formats include: Armenia, China, Denmark, Japan and Morocco.

2.6

iCal for appointments is now supported by CAS products

As of CAS genesisWorld x7, iCal for appointments is being supported in CAS products. The offers
a number of advantages:
External participants can now be added to appointments in CAS genesisWorld. External
participants are random contacts. If you wish, you can make these contacts available as
addresses in CAS genesisWorld.
A contact is added by entering an e-mail address as an — external participant — to an
appointment.
Appointment data is exchanged using the default iCalendar format with e-mails: all external
participants are sent an e-mail with the appointment attached.
As a CAS genesisWorld user, you can also receive invitations in iCal format from random
contacts. If you now open these invitations using the CAS genesisWorld e-mail client, then
you can opt to either accept or decline.
Appointments sent to you by e-mail which you then accept are entered automatically into
your CAS genesisWorld calendar.
In this case, the following prerequisites apply:
All CAS genesisWorld users have a unique e-mail address which is also saved to the database.
Users use the CAS genesisWorld e-mail client to respond to invitations and accept invitees
responses.

What has not changed?
If all participants are CAS genesisWorld users, then there is no change to the way
appointments are managed.
The process of inviting other CAS genesisWorld users has not changed.
Common appointments are available in CAS genesisWorld for all users and contacts who have
been entered as appointment participants.

What has changed in appointments?
The following section differentiates between two types of appointments, in each case, users have
various options:
An appointment in CAS genesisWorld has one or more participants, who are CAS
genesisWorld users. You can invite external participants to this appointment, for example, by
entering an e-mail address or by searching for an address.
An external appointment can be created by a user with an e-mail program such as Microsoft
Outlook. This user enters contacts' e-mail addresses as participants. These contacts are all
users of CAS genesisWorld and will subsequently receive an e-mail with an invitation.
In the CAS genesisWorld calendar all external appointments and appointments that have
external participants are marked with an icon.

2.6.1

User options

Inviting external participants
Users can invite external participants to appointments, as well as edit such appointments and
react to other appointment invitations. Each of these actions results in the automatic creation
and sending of e-mails in CAS genesisWorld that exchange data using the iCal formatted
attachments.
As soon as users have entered an e-mail address in the participants field or added an address
from the address search into the Select participants window, an appointment invitation is
sent to these e-mail addresses.
The first user who adds external participants to an appointment, becomes the organizer of the
appointment. All e-mails related to this appointment are then sent in the organizer's name.
Any change made to an appointment directly impacts the following fields: Subject, Start,
End, Participants, Location and Notes – thus a new e-mail containing the revised data is
then sent to the external participants.
Sending updates is mandatory when at least one future time reference has been affected, for
example, the times or dates of an appointment. Where such changes have been made you will
not be able to save the appointment without first confirming the sending of the updated
information.
Sending updated information is dependent on the user's decision, for example, if the start
and end points are both in the past.
If an organizer does not make the changes themselves, but instead another participant
changes the appointment, then the update is sent to the external participants in the
organizer's name.

The appointment organizer receives the participant's response to the appointment as an
e-mail containing an attachment in iCal format. If this e-mail is opened using the CAS
genesisWorld e-mail client, then the invitees response is transferred automatically to the
appointment.
In the open appointment, the status of the invited participants is visible next to their e-mail
address in the Participants field: has not responded, accepted, tentatively confirmed,
canceled.
The reaction of external participants can also be changed manually. In the Response field of
the Select participants window, you can enter a status using the dropdown list.
As soon as external participants are invited to an appointment, the maximum external access
right for all CAS genesisWorld users is set to Read.
An appointment containing external participants cannot be converted into another activity.

Participating in external appointments
If a CAS genesisWorld user receives an invitation to an appointment in the form of an e-mail
with an iCal formatted attachment, the CAS genesisWorld e-mail client will offer the user the
most suitable functions.
E-mails with iCal invitations to appointments are displayed in the e-mail client with a calendar
preview of the user's own calendar for the day of the appointment. Additionally, the
appointment data is displayed in HTML form.
The following three buttons are displayed via the calendar preview: Accept, Decline,
Reserved.
Accept and Reserved: the appointment is created as a CAS genesisWorld data record
including all available information such as keywords, location, start, end, notes. The user is
entered as the participant who received and accepted the invitation.
Decline: in this case, the appointment is not created in CAS genesisWorld.
In all cases, an e-mail containing the response is sent to the external organizer of the
appointment.
An e-mail containing an appointment update, has to be fetched using the e-mail client. The
updates are then automatically transferred to the appointment, whereupon a revised
response is required from the participants.
Please note, iCal support cannot be used for recurrences and invitations for recurrences
cannot be accepted. In CAS genesisWorld e-mail addresses for individual appointments in a
recurrence can be accepted as participants, but not the whole recurrence.

Settings for iCal support
Your administrator activates iCal support in the Management Console >
Miscellaneous/Activities > Appointment tab Use invitation management for
appointments. In the process, the system checks whether all users have a unique e-mail
address.
In addition, you can set Automatically link addresses so that e-mail addresses entered for
an appointment that are searched for and found are automatically linked to the appointment.
In the process, you can set exceptions for specific e-mail addresses or whole domains which
subsequently will not have links created for them.

2.6.2

Module specifics

Replication
Basically, notifications are only sent from the user's domain who organized the appointment.
If the appointment is changed in another domain, then the notification is sent to the
organizer's domain once replication is completed.
CAS genesisWorld Web, teamWorks and Mobile apps x7
All appointments can be edited as usual. E-mail with updates or cancellations are created
automatically and sent.
The e-mail addresses of invited participants are displayed and cannot be changed.
Mobile apps for x7 will be released soon.
Mobile sync
As usual, users can create and edit appointments. Adding an e-mail addresses that belongs to
a CAS genesisWorld user adds them to the appointment as a participant. However, adding an
e-mail address that does not belong to a CAS genesisWorld user adds them to the
appointment as an “external participant”.
The e-mail addresses from external participants are also transferred and invited as well as
being notified when an appointment is updated.

2.7

New functions in CAS genesisWorld

The Web Client based on SmartDesign technology will now be called CAS genesisWorld Web
as of CAS genesisWorld x7.

2.7.1

Flat Design

CAS genesisWorld Web has had its appearance comprehensively updated. The facelift is based
on the principles of Flat design. The style is recognizable through its graphically reduced and
minimalistic user interface, which is used throughout the whole application.

2.7.2

Radial menu

CAS genesisWorld Web has been extended to include the radial menu, a new innovative
operating concept. Using the radial menu, users can quickly access the application scenarios for
the different data records.
You can open the radial menu for each item in a list. There are two options available to you: you
can either left-click the radial menu icon, or right-click the column.

The radial menu functions follow a set structure. For each data record type there are three
default functions:
Edit
Dossier, open dossier
New tab, open data record on a new tab

Depending on the data record type, up to five additional functions may be offered. To aid quick
orientation, the functions have been ordered into four categories:
Default functions are marked in red and contain the names of functions such as: Edit, Dossier
and New tab.

Functions for communications are marked in yellow. With these functions, you can, for
example, call directly or write an e-mail.
Recording is marked in green and enables creating and linking.
Any additional information is displayed in blue and enables, for example, the direct opening
of a contact while you are making a phone call.

2.7.3

Resource planning

The new Resource planning app is available with Project, Timeclient online or one of our
industry solutions such as CAS Consulting, CAS Engineering, CAS IT Services or CAS Research.
The app offers an overview of employee workloads, taking data from projects, appointments and
holidays. The Time budget, ETC and Actuals display the aggregated key performance indicators
for each employee, the project and the individual processes.
Based on the set working time for a user in the Management Console, these times are calculated
to determine the workload for an employee. Projects and processes are included in this process,
for which an employee has been booked through a resource plan, this includes appointments
with planned processing time and approved holidays.
Next to the key performance indicators you will see the histogram which graphically displays
resource utilization. In addition, project duration and processes are visualized with the aid of a
Gantt view. Initially, this view includes your workload. You can add other colleagues using team
selection.
For those of you using the Timeclient online add-on module, the Resource planning app is also
available to you, with this app you can view your own workloads. The team selection is only
available with project or one of the industry solutions named above.

2.7.4

Event Management

As of now, you can create and edit new events in CAS genesisWorld. Additionally, you can
manage appointments and event registrations. However, Event online functions are not yet
available, for example, access to the registration URL or the sending of invitations by mail merge.

Events
With the Event Management license, you can display the new Events app.

You can create events, and now using the search function you can also access the last data
records or views that were used for an existing event.
In an event data record, you can use the additional functions to add an appointment or a
registration to an event.

Existing appointments are displayed in a list. Existing registrations are grouped according to
status and displayed together with the number of registrations.

Clicking a status opens a list view of registrations with this status. Clicking Select in this view
enables you to mark items in the list using the checkboxes on the left of the view. Now, if you
click Change status a drop-down list of statuses opens. Selecting a new status from the dropdown list changes the status for the registrations you marked.

Event appointments
For event appointments, the respective event is displayed in the Event details. You can add an
appointment to an appointment groups and define this as a mandatory appointment.

Event registrations
You have the same options for events as you do in the desktop client. For example, if
registrations for individual appointments are permitted, then these appointments can be
selected via the Appointment registrations feature.

2.8

2.8.1

New Functions for the CAS genesisWorld Modules

Exchange sync

To prepare for using Exchange sync, appointment data records in CAS genesisWorld are specially
prepared. In the process, you can make settings that automatically accept the prepared
appointments during the initial synchronization of appointment invitations.

2.8.2

Project

As of version x7.0.0 you will find the customer dashboard settings in the Management Console >
Miscellaneous > Dashboards.

3

Software update x6.1.0

3.1

Updated instructions

User guide Survey
User guide Event Management

3.2

Extending the update service

Once an update has been installed, you can make settings in the configuration wizard to make
these updates available in other folders.
Open the (CASUpdateServiceConfAssistant.exe) configuration wizard in \CAS-Software\Server.
Open the Additional distribution window.
Activate the Additional distribution and enter the folder you want to use.
The folder you enter can also be used as the source folder for update services on other
computers.
When calling the HotfixSetup.exe all of the installed updates are displayed, independent of the
way and manner in which they were installed. If the update service is active, a note is displayed
and other actions are blocked.

3.3

New features in the Management Console

A new action field is now available in the notification and action service: SmartDesign Link. The
field's functionality is similar to that of the Link to CAS teamWorks action field and inserts a
data record link into the CAS genesisWorld Web Client.
You have to enter a suitable URL for the CAS SmartDesign Web Client on the server settings
tab in the rules area.

3.4

Changes to the Windows client

Button positioning and the display of values in the change log
The button positions have been changed for buttons used in the displaying and accepting of
previous and new values, so that now, the button for previous values are always on the left,
and the button for new values is always on the right. The button positioning is now
chronologically ordered.
Likewise, in the Changes window, the details are displayed in such a way so that the previous
values stand on the left and the new values on the right.
Importing addresses

For imported addresses, if not already set by the import file, the default contact data is set for
up to 3 e-mails, telephone numbers and fax numbers respectively.
Automatic setting of the default contact data is also carried out in the Windows Client if an
address is opened and the default contact data has not yet been set.
The address wizard includes default address settings
When creating individual contacts administrators can define settings in the Management
Console, and users in the settings, that determine whether or not companies, delivery or
private addresses are displayed on opening.
This setting also applies to the address wizard, so that address fields are inserted that
correspond to the set address.
Customized country formats: Armenia, China, Denmark and Japan.

3.5

SmartDesign Web Client news

A HTML editor is now available for improved notes editing. Using the new editor you can now
insert formatting, pictures and tables into notes.
The delete appointment button in the calendar is now also available in the small window that
opens when you click an appointment.

3.6

3.6.1

New Functions for the CAS genesisWorld Modules

Survey

When opening a questionnaire on a smartphone, the display of the questionnaire is now
adapted to fit the smartphone display. This function is available for browsers as well as for the
CAS genesisWorld app.
The report for surveys has been extended to include, among others, the display of survey status.

3.6.2

Duplicate Finder pro

A preview with a list is available for Duplicate Finder pro. The number of duplicates found are
sorted and displayed according to address type (company, contact person, individual contact).

3.6.3

Exchange sync

To prepare for using Exchange sync, appointment data records in CAS genesisWorld are specially
prepared. In the process, you can make settings that automatically accept the prepared
appointments during the initial synchronization of appointment invitations.

3.6.4

Helpdesk

The changing of input assistance option types for the following process fields has been locked:
satisfaction, error cause and priority.
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4.1

Updated instructions

User Guide Form & Database Designer

4.2

Updated releases

Mobile sync for devices running BlackBerry version 10

4.3

CAS Smart add-on

The new CAS Smart add-on has been released to enable the continued flexible use of both the
CAS genesisWorld Web Clients, namely: teamWorks and SmartDesign with the various browsers.
The CAS Smart add-on is a new application which replaces the previous CAS browser plugin. You
will need the CAS Smart add-on for specific functions such as the displaying and editing of
documents.

Installation
CAS Smart add-on has to be installed on all of your computers.
When a user first calls a respective function, they will receive a message from the system
inviting them to install the CAS Smart add-on.
After installing the function has to be called again. To use the CAS Smart add-on, you have to
start the application. This varies depending on your browser.

The following figures show Mozilla Firefox, Google Chrome and Internet Explorer.
If the Save selection for cas links and My settings for links of this type options are
activated then this message is no longer displayed.

The CAS Smart add-on can also be installed via the MSI distribution list. Once a user has called
a respective function, all they have to do is allow the application to start in their browser.

4.4

New Windows Client functions

Current users in action
You can now select the Current user for fields that have participant selection in the Action
window. If a user executes this action, then the Current user is entered.

4.5

New functions in the Microsoft Outlook add-in

In Microsoft Outlook you can archive e-mail attachments individually or through checkbox lists
as documents in CAS genesisWorld.

When selecting an e-mail attachment you can use the new function on the toolbar in the
Attachments tab

Archive as document creates a document data record for the attachment in CAS
genesisWorld.
The settings for the add-in have to be available, see
http://hilfe.cas.de/CgW/de/Windows_Client/x6/index.htm#MicrosoftOutlookInstallierenEinrich
ten.htm
The Quick archive function is used for archiving.

To archive multiple attachments as document data records, open the contact menu in the row
with the attachments and click Save as document.
The Save all attachments window will open.
Select the attachments you want to archive in the window and confirm with OK.

A document data record is created in CAS genesisWorld for each attachment you select.
After archiving, a document list with the archived attachments will open, if a CAS
genesisWorld Windows Client is installed.

4.6

4.6.1

New module functions

Easy Invoice

When exporting receipt data using the Accounting transfer option in the receipts context
menu, the Accounting transfer on field of the receipt is no longer locked. The date can be
deleted to re-export the receipt.
When creating a receipt, the title and full name of the user creating the receipt are entered into
the Responsible for receipt field if this user has been assigned an address. Otherwise, the
username of the user creating the receipt is entered.
The print templates for Easy Invoice have been revised. If the print templates have not been
adapted, then the new versions are all available after you have updated.

4.6.2

Duplicate Finder pro

The add-on module Duplicate Finder pro, used for searching for and resolving duplicates, is now
available in English.

4.7

SmartDesign Web Client news

A HTML viewer has been integrated for the improved display of formatted notes and archived
e-mails. Thus, formatting, images and tables can be displayed.

Users can copy, save or send direct links to data records, apps or lists from the address row of
the browser. In this way, for example, you can always start the Web Client with the calendar
via a bookmark.
The address check now includes the Country (default) value that has been configured in the
Management Console and in the Windows Client. Changing the country in the data record
leads to a new address check.
The date is now displayed in the dossier in the form and the extended list.
In the calendar a new button leads you directly from a team calendar back to your own
calendar.

The Resource plan app has been extended so that now it's possible to create resource plans.
If a 64bit operating system is being used on the application server, then a 64bit Java virtual
machine is used automatically.
Please consider that some of the following new features require the use of a current database.
You should be using a database version of CAS genesisWorld x6.0.4.

4.7.1

Products & receipts

The Products & receipts new group of apps includes the Products, Product groups and
Receipts apps for the data record type of the same name.
Products can be created and linked with product groups.
Receipts can be managed depending on the add-on module you are using.
Using the ERP connect module, users can create new receipts or edit existing receipts.
Using the Easy Invoice module, users can open receipts in read-only mode.

4.7.2

Service & support

The Service & Support new group of apps includes the Service agreements, Product uses,
Tickets, Time record calendar and Time record apps. This group is visible when the Helpdesk
add-on module is being used.
The x6.0.6 software update makes basic Helpdesk functions available in the SmartDesign Web
Client. However, the complete functionality, as found in the Windows Client, is not yet available.

Service agreements
You can create and edit service agreements.
New service agreements can be created in the extended list or for contacts as soon as you have
called the app. In the process, the contact or company is automatically entered as the service
agreement customer.
An open service agreement displays a list of all the linked product uses. Using the additional
functions button, you can add more product uses.
Service agreements show the reference currency from CAS genesisWorld for all the currency
fields in the data record.
Implementation of the due dates for reaction times and calculations for fields in the
Maintenance panel will be included in one of the next software updates.

Product uses
You can create and edit product uses.
New product uses can be created in an extended list, for contacts or for service agreements
directly after calling the app.
If the initial data record is a contact, then the contact or company is entered automatically as the
customer. And if the initial data record is a service agreement then a link is created between the
product use and service agreement automatically. The service agreement customer is
automatically adopted as the product use customer.

Tickets
A custom app is available for tickets. The search and the views you see after starting the app
display both tickets and jobs. Likewise, tickets are labelled as Jobs in the app.
New tickets can be created through contacts, phone calls or e-mails. In the process, a primary
link to the company or customers is entered for the tickets through a support project. The
transfer of the respective contacts as customers and/or submitters is just as it is in the Windows
Client and includes the settings in the Management Console.

If your screen displays more than 1500 pixels in width, the format for the ticket data record will
be 3 columns instead of 2 columns as in the rest of SmartDesign.
With the x6.0.6 software update the basic ticket functions are available in the SmartDesign Web
Client.

Time record calendar
The Time record calendar can be found in the Service & Support group as well as in the
Project Management group.
To create a new time record in the Time record calendar a time slot is selected. You now have 3
options:
New time record
Create a time record from the history
Create a time record for the resource plan.
Using the Quick entry button, time records for appointments without overlaps are created
automatically in the time period displayed. This is then included in the time period set in the
Management Console. If two appointments overlap, then the user will select an appointment for
the time period.

4.7.3

Timeclient online

In this version, the Timeclient online functions are available in the SmartDesign Web Client. Users
with a corresponding license will have access to the respective apps.
With this you can create expenses and time records for different data record types and
corresponding appointments, resource plans and reports are available.
Please note that Timeclient online, as of CAS genesisWorld x7, is being replaced by these
functions in the SmartDesign Web Client.

4.7.4

Contact persons for opportunities

In opportunities, you can add contact persons with different roles. And, just as in the Windows
Client, all the links defined in the Management Console are also available here.

4.7.5

More functions for form letters

Form letters via individual data records and via the list are now possible in the Windows Client.
For example, you can now create an offer including product items and the parent elements from
an opportunity. In the process, the customer is automatically adopted as the recipient.
To enable document language support, this field is now also available for documents. And now
the output language of target country is also supported.

Important
Permitted contact types are always included.
If users have images available as field variables, then these files have to be stored in a central
network folder. Additionally, all clients must be able to reach this network folder using the
same path.

4.8

Mobile apps

4.8.1

Android app version 16.0.2

Select data records for offline access
The possible data record types for offline access have been extended to include: contacts,
projects, jobs, tasks, opportunities without product items and receipts without receipt items.
Users can select the individual data records which they want to save to the end device. These
data records can then be accessed even if you do not currently have a connection to the
Internet.
Phone calls and appointments will continue to be saved for the last two weeks, and for the
next six weeks. Beyond this time period, appointments and phone calls can be selected (as
with other data records) for offline access.
In the app settings you have to activate the Locally saved data.
SmartSearch
SmartSearch now enables you to also search in your own app on the mobile clients, for
example, if you are looking for addresses, appointments, documents, projects, processes and
tasks.
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5.1

Updated instructions

User Guide Helpdesk available in English and German
User Guide Mobile CRM for Windows available in English and German
User Guide Project available in English and German
User Guide Report available in English and German

5.2

Releases

Omikron AdressCenter Version 2.0.5
Crystal Reports 2013 SP4

5.3

New functions in the Management Console 

In the Miscellaneous area for E-mail on the General tab you can set how many mail merges
you want to send in a time interval.
If you have set an upper limit (maximum number) that you would like send in a specific time
interval, then CAS genesisWorld will only forward this quantity of mail merges to the e-mail
server. As a result, you can better support e-mail servers which only send a certain number of emails within a given time interval.
This setting has no effect on the sending of e-mails using the CAS genesisWorld e-mail client.
The setting will also work for notification service e-mail account.

5.4

More new features

SmartSearch
To date, SmartSearch had to be activated on every CAS genesisWorld application server being
used. Now, the service only has to be configured and activated on one of the application
servers being used.
Please note, you will have to update the database using the Database Wizard.
View formats for dashboard elements
You can set a saved view format for a list in an element when configuring the element.
Dragging and dropping files and documents
If using drag and drop you drag a file from the desktop or Windows Explorer and drop it into
an appointment in the calendar, then the newly created document is linked to the
appointment automatically.
Number of e-mail recipients in the suggestion list
If you write an e-mail with CAS genesisWorld, it suggests up to 99 e-mail recipients from the
list of people you last wrote to.

5.5

5.5.1

SmartDesign Web Client news

Extended support for Exchange sync

Even if the Exchange sync add-on module is being used, you can still create and edit
appointments in the Web Client with SmartDesign albeit with some restrictions.

Users can create appointments for themselves. In such cases, the Read right is set
automatically as the maximum level of external access rights, you can also select Private as an
external access right.
In an existing appointment which has multiple participants, you can edit appointment data in
the SmartDesign Web Client with two exceptions: you will not be able to change the
participants for an existing appointment or change recurring appointments.
If the organizer changes an appointment, then as usual, automatic notification e-mails are
sent to the participants as long as the appointment has not already occurred.
If a user, who is not the organizer of the appointment, makes changes to the appointment
then a so-called shadow appointment is created for this user.

5.6

5.6.1

New Functions for the CAS genesisWorld Modules

Form Designer

You can now move content (scroll) horizontally and vertically when customizing tabs using the
Form and Database Designer in the Management Console.
In the Windows Client windows that are too small will not have scrollbars.
Administrators should remember that customized tabs are also displayed in clients that use a
low resolution.

5.6.2

Report

Data from a report view or report template can be exported, for example, for Crystal Reports.
Contact addresses can be consistently exported using all 7 rows, similar to that for the special
Address fields for a form letter.
You can activate the export of address fields in the report view properties or report templates
when selecting fields for querying addresses by activating Make address fields available for
export. The exported fields are entitled ADDRESS_ADDRESSLINE_ and are available for
companies, suppliers and private addresses:
BUSINESS
DELIVERY
PRIVATE

In the exported file, you will see that each address field has its own field numbered from 1-7 and
a field that ends in ALL, which contains all the address fields for the respective address. For
example, these fields can then be placed in a report using the Crystal Reports Designer.

5.6.3

Project

The per diem expense rates for Germany 2015 are now delivered in an XML file. Under Expenses
in the Project area of the Management Console you can adopt the new rates for all the
countries, regions or cities that you created as input assistance options for the Country field in
the Expenses data record type.
For recording expenses, the complete list of all countries and regions is published annually by
the Bundesministerium für Finanzen (Federal Ministry of Finance). The XML file is based on this
list, you will find the file in the ..\CAS-Software\CAS genesisWorld\Client\Expenses folder.
To update the expenses rates, the input assistance options for the Country field in expenses
have to agree with the country or region listed in the XML file. The ISO country codes are used as
the country codes in the XML file. Thus, it is important that the values used for country input
assistance options in expenses are the same as those used for the country input assistance
options in addresses so that they can be allocated correctly.
If you are using both the Project module and the Easy Invoice module then you will be able to
generate work reports based on the time recording values. And if, for example, product
description or product name are included in lists of items in the Easy Invoice area of the
Management Console, then this setting is adopted for the work report.

5.6.4

Easy Invoice

Under General in the Easy Invoice area of the Management Console you can configure lists of
items to be displayed with either the product description or with the product name.
When selecting the Product description field, the Product name field is automatically adopted
into the print document if the Product description field is empty in the line item.
You can export receipts in CSV file format for forwarding to the accounts team. You will find the
export function in the lists shortcut menu for receipts. The following prerequisites must be met:

The Easy Invoice license is unlocked for one user.
The user has exports rights.
The receipts have a statistical factor of 1 or -1 for an invoice or credit note.
Print documents have already been created for the receipts.
The administrator has already defined which fields are to be exported in the Easy Invoice
area of the Management Console under Accounting transfer.
The administrator has set up the necessary taxes and different revenue accounts under
Accounting transfer.
The print documents for Easy Invoice have been adapted to display an approved discount clearly.
If the Project module is being used, then work reports can be created based on time recordings.
Using the configuration under General, works reports can be created containing lists of items
and their respective information.

5.6.5

Survey

Now, with e-mail notifications for questionnaires and when adding participants to surveys, the
system checks whether e-mail has been selected as a permitted contact type for the selected
addresses. If this is not the case, then a dialog box opens. However, users can choose to ignore
the dialog and send notifications to the addresses anyway, or add them to a survey.

5.7

New module: Duplicate Finder pro

Duplicate Finder pro is a new module that specifically searches for duplicate addresses in CAS
genesisWorld.
Duplicate Finder pro finds three types of duplicates which are checked in three separate search
runs:
Multiple company address entries
Individual contacts for companies with contact persons
Multiple contact person entries
You can search all of your address stock. Alternatively, you can restrict your search to a specific
selection or enter a reference quantity of addresses that you want to search for duplicates.
Duplicate Finder pro makes duplicate criteria available in the form of one or more search
profiles. Uses who have been granted sufficient permissions can create, change and save these
profiles in the Windows Client.

A search profile is available as a preset. Search profiles can be duplicated and changed. Search
profiles are always public so that all users who have been granted sufficient rights can use and
change search profiles.
Essential address fields can be weighted with respect to duplicate searches. You can also include
empty fields in these searches.
A threshold value determines the percentage of deviation at which two addresses are considered
duplicates and are subsequently displayed.
You can define whether the value should be compared identically or phonetically. For example, a
phonetical comparison of the Name field, results in the address for Smith being recognized as a
duplicate of Smyth and the Name field is weighted accordingly.
When searching for duplicates in companies and contact persons, the fields of other address
types are not compared, so for example, the Name field when searching for companies and
Company when searching for contact persons.
Please note you will have to update the database using the Database Wizard.
The Duplicate Finder pro add-on module will be available initially in German only with the
x6.0.5 version of CAS genesisWorld. Additional language support for Dutch, English, French,
Italian and Spanish will be available as of version x6.0.6 of CAS genesisWorld.
The Duplicate Finder pro license is not a component part of the Test and Presentation license.
Partners will be issued with licenses during the upgrade to CAS genesisWorld x7.
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6.1

Updated instructions

The content of the SmartDesign SSL reverse proxy user guide has been completely replaced
by the updated content of the following page Setting up the reverse proxy which can be
found in the server manager online help.
English online help for the Database Wizard and CAS genesisWorld Windows Client
Manual CAS genesisWorld Administrator x6 in English
Manual CAS genesisWorld First Steps x6 in English

6.2

Extending the data model

New fields were added to the data model through a database update.

Data record type

New fields

External services

Cost unit, Receipt

Expenses

Receipt

Job

Product use, Service agreement

Product use

Service agreement

Service agreement

Contact person (general), Contact person (delivery), Billing
address

Existing links use and write to all the fields. In the SmartDesign Web Client, expenses and
external services now display the respective links as in the Windows Client.
The Database Wizard is used to update the database. In the process, the data from the linked
data records is added to the existing data.
This process may take some time.

6.3

SmartSearch in the Windows Client

The SmartSearch function was introduced as an integral part of the SmartDesign Web Client with
CAS genesisWorld x6.0.0. We have now extended SmartSearch to include additional data record
types, SmartSearch is now available in the CAS genesisWorld Windows Client.
Searching includes the following data record types: addresses, appointments, documents,
additional projects, processes and tasks. The search results are displayed in a mixed list, whereby
the order of the search hits is determined by a calculated ranking. The following factors are
considered:
Quality of the hit - agreement of the search term with, for example, the subject
Relevance to the current situation - date fields and
Link strength - for example, user is a data record participant.
In the Windows Client, SmartSearch search is started when you enter a search term into the
search field on the toolbar in the program window. Once you have entered two characters, a hit
list is displayed which is subsequently updated with each extra character you enter. You can
navigate through the hit list using the arrow keys. If you scroll past the last hit additional hits will
be displayed.

Using the respective abbreviations, you can restrict your search to a particular data record
type, for example, DO will limit your search to documents only.
Depending on the data record type, users will be presented with additional options in the
context menu: for example, an address can be called directly, or you can display the calendars of
all the participants involved in an appointment, or even open the dossier.
The SmartSearch service has to be activated in the Server Manager. In addition, it has to be
enabled in the Management Console > Database > General > SmartSearch for each
application server that users will logon to, see section 10.8.
Pressing the return key after you have entered the search term opens the Search window and
usual associated options.
The following table contains an overview of the indexed fields per data record type:
Data record type

Indexed fields

ADDRESS

Name, ChristianName, CompName, CompName2, Town1-3,
MailFieldStr1-5

DOCUMENT

Keyword

APPOINTMENT

Keyword, Notes

PROJECT

Keyword, Prjnumber

TODO

Keyword

TASK

Keyword, Tsknumber

An index is also created for the Notes field. This index is then used if a search is only carried
out for one data record type.

6.4

Extending the update service

In the first version of the update service, updates could be carried out automatically on
computers where only the Windows Client and the Management Console were installed. The
update service has now been extended, so that all components of CAS genesisWorld can be
updated that is the Windows Client, Management Console and Application Server.
If CAS genesisWorld is installed with administrator rights, then the update service is installed and
started automatically. If the service is running with the Update check enabled, then the system
checks a designated folder at regular intervals for available updates that can be subsequently
installed.
For installations with the application server, downloaded updates are installed in the
background. Updates that do not use the application server are executed so that the user can
follow their progress.
You will find more details on the update service in the special Update Service User Guide.
You will not be able to install a main version, such as for example x7, using the update service.

6.5

New functions in the Management Console

Field settings influence, among other things, the way that fields are displayed in lists in the
Windows Client and SmartDesign Web Client as well as influencing export functions.
Depending on the data type of the field, these settings vary, they can be defined in the
Database area of the Management Console.
Some settings can be changed for standard fields, others not. As usual, you can change all
settings for personal fields.
The following new settings are available for all data record types:
Notify
If this option is active, then the field is listed in the change log when there is a notification.
Globally

In list views in CAS genesisWorld, multiple data records are highlighted and changed with
Action/Other actions. You can use the Global change option to allow or deny changes to
fields by such actions.

More settings in the tab format
The appearance is defined according to the datetime data type
For Date field types you can define exactly how you want the date to be displayed:
Date and time (to the second)
Date and time (to the minute)
Date (to the day)
Time (to the second)
Time (to the minute)
Decimal places and duration for the float and decimal data times
In the lower pane of the tab, you will see a preview pane in which you can see the effects of
the settings.

6.6

Changes to the Windows client

Corporate group dossier
If addresses are linked to a corporate group structure via parent and child links, then
information can be displayed for all associated addresses including contact persons in the
dossier. The corporate group dossier supplements the company dossier and the overall
dossier.
Child links are included in the open data record. So that, for example, you can display all of
the subordinate addresses.
When working with the Form Designer, users can select the Corporate group dossier when
working with link lists for addresses, and in Report when including linked data records.
Notify users of undeliverable e-mails for new e-mail accounts
When setting up a new e-mail account in CAS genesisWorld, the system checks whether the
e-mail server supports undeliverable notifications when sending. If this is the case, then this is
automatically considered for a new e-mail account. Undeliverable notifications are then
supported by the CAS genesisWorld e-mail client when sending e-mail.
Unternehmensverzeichnis.org directory
If the company is linked to the Unternehmensverzeichnis then the
Unternehmensverzeichnis.org logo is displayed in the contact person's data record.

If an address could not be assigned to a company in the Unternehmensverzeichnis.org after
the first check, and the EBID status undefined, then the system continues to check at 60 day
intervals.
Formatting of Austrian area codes
The automatic formatting of phone numbers has now been expanded to include Austrian area
codes.
Sending e-mails from tree views
In tree views you will see e-mail functions such as Send e-mail to participant and Send CAS
genesisWorld data record in the context menu of the data records and on the toolbar.
Changes have been made to the following country formats:
Brazil, Hong Kong, Canada and Lichtenstein

6.7

SmartDesign Web Client news

We've packed a number of new functions into the SmartDesign Web Client for version x6.0.4 of
CAS genesisWorld
The browser's refresh function is now supported. If a page is refreshed by pressing F5, or the
respective function is refreshed, then all of the content displayed is also reloaded from the
server.
Touchscreen operation has been significantly improved and is now state-of-the-art. Internet
Explorer 11 the Metro version used in Windows 8.1 offers particularly good support. This means
you can now attach a tile to the start page of Windows 8.1 in different sizes with an icon.
In the calendar, you can now open forms for editing directly from the preview without having to
go to the read-only view.
Now when editing and reading, the fields containing sums display the currency that is currently
set directly in the field. If a currency field is available for this data record type, then the set
currency is used, otherwise the reference currency set in the Management Console is used.

6.7.1

Automatic recording and checking of addresses

Address wizard

It is now possible to create a new contact with just a click of the Address Wizard button, just as
you would in the Windows Client.

For example, the address text from a document, from an Internet page or an e-mail is copied
first of all to the clipboard and then into the Address Wizard window.
As far as possible, this information is entered into a contact's fields automatically. Text that
cannot be assigned to a field is entered in the Notes field.
Data entered in the address wizard is sent to a CAS Software AG Web service over a secure
Internet connection (https). Converting the data to an address is a complex logical procedure
and takes place on the CAS Software AG servers. The result is then returned and displayed in
the address wizard over a secure Internet connection.
CAS Software AG does not store or use any of this data for its own purposes.
For you to use this function, the CAS genesisWorld application server must be connected to
the Internet. If you receive an error message, please contact your administrator.
The address wizard has been optimized for addresses from the German-speaking countries.
You might experience restrictions with addresses from other countries when you are allocating
fields.

Automatic address check
Now when creating a contact, specific fields are completed automatically, or values are
suggested. Existing entries are not overwritten. If suggestions are made for fields that have
already been completed, then these are marked with an exclamation mark. Clicking the
exclamation mark opens a list of possible values.
The automatic address check has the same functions as the Windows Client. Customizations
made by the administrator to the respective files are also included in the Web Client.

6.7.2

Windows authentication

As of this version, the Web Client also supports Windows authentication if this is possible for a
user.
With the Automatic logon option, a logon is attempted using the Windows logon. You can also
use your Windows username and password for this logon.

The Save username option, is no longer displayed, however, the function is always active.
If the Windows authentication is successful, then the Web Client will start directly next time using
the logon. To change the logon again, you will have to explicitly log off.
If the Windows authentication is not possible, then the standard browser window will open. You
can enter your Windows username and password into this window.
You can log on using the Mozilla Firefox browser if you enter the Web Client URL for the NTLM
authentication under about:config.

6.7.3

More news

Deleting links
A suitable, new button is displayed after activating the button in an extended dossier list for
selecting data records.

In addition, the Link type column is displayed. Data records that have been linked with
multiple link types will be displayed more than once.
App for archived e-mail
You can use the app to search all archived e-mails. The content and any other data is
displayed and you can work with the attachments. Using the buttons, you can open existing
reports or link e-mails with other data records.
External services
The Cost unit for addresses and Receipts for documents are displayed for open external
services elements.
External services can be created directly for projects on condition that the database has been
updated to this version.
Expenses
The type of expense is displayed as read-only in editing mode via status, when one of the
following types has been selected: Lump sum km bill or Per diem.
Now, when you create a new expenses receipt, you will be offered all the different types of
expenses receipts from which you can select the type you require, except for three special
types: Lump sum, km billing and Per diem.
The Receipt to documents link is now displayed as an element.
The prerequisite for this is that the database has been updated.
Currency is displayed as a unit.
External services and expenses display the CAS genesisWorld reference currency as a unit for
all data record currency fields.
Project items display the selected currency of the data record as a unit in the currency fields.
Selecting a user
In resource plans you can change the user, as long as plan times have not yet been recorded.
In expenses, you can also change the user as long as the data record has not yet been billed
internally.
Users can also be changed when creating a new time record.

6.8
6.8.1

Mobile apps
iOS app version 16.4

Type and Status fields

The Type and Status fields are displayed in addresses, appointments, documents, tasks,
processes, projects and phone calls, and can be edited if you have sufficient rights to do so.
If settings are type dependent, then they are not included, for example, mandatory fields.
SmartSearch
SmartSearch enables you to also search in your own app on the mobile clients, for example, if
you are looking for addresses, appointments, documents, projects, processes and tasks.
Connection to the Unternehmensverzeichnis.org
Contacts that are connected to the Unternehmensverzeichnis.org are marked accordingly, as
such you can access more information about the company by navigating to the company
website directly through Unternehmensverzeichnis.org.
Displaying the last logon
After logging on to CAS genesisWorld, you will receive a notification informing you of the last
logon. You will see this information in the app settings.
The functional capabilities have been improved with the iOS8 operating system.
Holiday status is displayed on both the dashboard and in the calendar.

6.8.2

Android app version 16.0.1.1

Improvements to caching performance
We have improved the synchronization of information for read-only access to appointments,
holidays and phone calls.

6.9

6.9.1

New module functions

Project: New functions for Per diem

The Per diem allowance file 2014 for Germany, now contains all the states as issued for 2014 by
the German Federal Ministry of Finance. If a new country was added to the input assistance
options for the Country field, then you can ensure that you have loaded the correct expenses
allowance data from the file for use in the Project and Expenses area by simply clicking the
Refresh button
Initially, when activating the project module, the settings for Germany are loaded. Furthermore,
the existing standard countries used for recording expenses are created, any additional countries
have to be added manually.

Only the settings for the current year and the following year are loaded. If an expenses
allowances file for the following year is not yet available, then the system will continue to use the
old values until you update them. These values can be updated as soon as they become
available.

6.9.2

Report: Aggregating values from available queries

Now, in report views you can use a pre-calculated value to aggregate a field, or value from a
calculated formula field in a query, in the same view. This negates the restriction whereby you
can only include and aggregate fields via links.
You have two options open to you with the configuration of pre-calculated values: the previous
behavior using Use field from linked data record and the new Use the field or calculated
field from the query.
If a field or linked query is used, the value is not displayed in the report data.

6.9.3

Inxmail: Report now available in different languages

Distribution list reports for Inxmail Types can now be created in languages other than just
German. You can define the languages in the Management Console > Miscellaneous > Inxmail
> Other settings. A default language can also be set. In addition, reports are created in the
user's own language, if the language is supported.

Please note that not all the languages supported by CAS genesisWorld are supported by
Inxmail.
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7.1

Updated instructions

The English language online help for users version x6 has been updated.
The English language online help for the Server Manager version x6 has been updated.

7.2

Releases

Citrix 7.5

7.3

Changes to the Database Wizard

Before updating a database, the compatibility level is detected automatically and then displayed.
Only when the compatibility of the database corresponds to at least 100 (currently at least SQL
Server 2008), will you be able to carry out an update.

7.4

Changes to the Management Console

Improvements to the rules area of the Management Console now enable you to call the rules
view much more quickly than before.

7.5
7.5.1

Changes to the Windows client
Integration into the Unternehmensverzeichnis.org directory

Any documents you purchase from Unternehmensverzeichnis.org can be transferred to CAS
genesisWorld automatically as archive documents if the following requirements are met:
The associated address is available in CAS genesisWorld and the unique EBID number has
been entered for the company address in the Unternehmensverzeichnis.org.
The document was bought from Unternehmensverzeichnis.org using the user account that
has been entered in the account information area of the Management Console.
Any documents you purchased from Unternehmensverzeichnis.org can be accessed for up to
two weeks after purchase.

After having been transferred to CAS genesisWorld, the documents will not expire and are
available as archive documents that can be linked with the respective address. Any documents
you purchase from Unternehmensverzeichnis.org will be available in the dossier for the
respective company.
In the Management Console, you can define which participants are entered as document
participants for any documents purchased from the Unternehmensverzeichnis.org.
Currently, you can only buy SCHUFA compact credit reports from
Unternehmensverzeichnis.org.
For more information, please go to Unternehmensverzeichnis.org directory.

7.5.2

Changes to the calendar

Appointment duration now displayed
Short appointments are displayed at the minimum height in the calendar. The actual duration
of the appointment is indicated by an overlapping rectangle that is displayed vertically on the
left-hand side of the appointment in the calendar.

Moving appointments easily
You can lengthen and shorten appointments in the calendar in 15 minute intervals.

7.6
7.6.1

News for the SmartDesign Web Client
Mandatory primary links

Mandatory primary links for parent elements are now supported, you can now change and edit
primary links both in the edit and read-only views.
Elements outlined in red are mandatory elements and, thus, have to be selected.

7.6.2

Project management

In addition to the existing apps of: Projects, Jobs and Time record, the new Project
management app group now also includes the following new apps: Resource planning,
Expenses and External services.

Time record
The Time recording app in the Project management group displays your resource plans.
The registered users can directly record the time for resource plans that have been assigned to
them, and no longer have to open the associated job.
You can add time recordings without links by clicking the plus sign.
The Status field is now available in the read view and when editing time records.

Resource planning
Using the new Resource planning app in the Project management group, you can create,
search and edit resource plans.
In the SmartDesign Web Client, the Time budget, ETC and Primary link fields, can be changed
by resource plans. The user cannot be changed in the Web Client, as the logged on user is
always entered. Thus, you can only create custom resource plans in SmartDesign.
In the read view of a resource plan, you can create new time records for a primary job of the
resource plan. To do so, go to the menu for creating new associated data records.
Associated resource plans are displayed in a job read view, and can be opened for reading or
editing. Using the new creation menu for associated data records, you can create new resource
plans for a job.

External services
Use the new External services app in the Project management group, external services can be
created, searched and edited.
The read view for the External services data record type displays the basic currency that has
been set in CAS genesisWorld at the end of the Billing group.

Expenses
Now, expenses can be created, searched and edited using the new Expenses app in the Project
management group.

You can now create New expense allowance, New per diem costs, New km bills and New
receipt for expenses in open data records such as addresses, projects, jobs and appointments.
Once they have been created, none of the following values can be changed: Expense allowance,
Per diem or km billing. When creating a new Receipt for expenses, you can choose between
Hotel, Train, Taxi and so on.
The expenses lump sum differs from the Windows Client in that it only displays the Turnover
field as the Net costs field is not relevant with this type of expense.
You will see a list of associated expenses in the detailed view of an appointment.
Please note that the Per diem rates have to be saved to the Management Console first. If you
create Per diem for a country, and you have not yet set these per diem rates, then the system
automatically uses the values for Germany in any calculations.
The read view of the Expenses data record type displays the basic currency that has been set in
CAS genesisWorld, the currency is displayed at the end of the Billing group.
The current restrictions apply to primary links in the Project module.
You can only change the primary links of Expenses, Time records, External services and
Resource plans in the Web Client if the data record is being edited.

7.7

7.7.1

Mobile apps

iOS app version x6.3

In the x6.3. update for the iOS app, the following new functions are available:

Deleting data records
Besides appointments, you can now also delete the data records of other data record types, as
long as they can be edited while mobile and the user has the necessary rights to do so.

Compatibility with iOS8
This version supports the use of the CAS genesisWorld iOS app in conjunction with the new iOS8
operating system.

7.8
7.8.1

New module functions
Project

With immediate effect, you can enter per diem rates for 2015 and subsequent years into the
Management Console > Project area > Expenses.
When adding new annual rates, your administrator can adopt the rates of the previous year, or
read out the new rates from a file. Suitable files will be made available with future software
updates, as soon as the new rates are known.

7.8.2

Survey

Now, in Phone calls for Opportunities, on the Questionnaire tab, you can display the generally
linked opportunities belonging to questionnaires.
To do this, activate the function in the Survey area of the Management Console. There you can
select the Phone calls option in Display questionnaires of parental data records for.
Please note that selecting this setting in the Management Console results in the the
questionnaire primary linked addresses, projects and processes also being displayed in the
phone call, in addition, they can also be created via the phone call.

7.8.3

Helpdesk

E-mails can now be sent dynamically to recipients from text fields via this ticket action.
All of the varchar and text data type fields can be selected as e-mail recipients. You can enter
multiple e-mail addresses and usernames into the selected field, by using commas (,) or
semicolons (;) to separate the items. All indicated e-mail addresses and users receive a copy of
the e-mail. To write to a user, there must be a valid e-mail address saved in the User
management area of the Management Console.

7.8.4

Form Designer

Fields with user choices in tasks such as Processed by are available as virtual address links in the
Form Designer. If an employee link is added to an address data record for a selected user, you
can use fields in the associated address in formulas.
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8.1

Updated instructions

The online help for the Management Console version x6 in English has been updated:
http://hilfe.cas.de/CgW/en/Administrator/x6/index.htm#Inhalt.htm

8.2

Releases

Microsoft SQL server 2012 SP2
Safari 7

8.3

New functions in the Management Console

Names with supplements such as: de, van, von and so on, can be found under the respective
letters of d or v when sorting an address list by name. To save the name supplement separately
from the names in the database, you have the option of activating a new field.

In the Miscellaneous area of the Management Console the Use name prefix option is now
available under > Addresses > General tab. If this option is active, the Name prefix field will be
available. So for example, if you enter the Netherlands into the Country field, then this field will
be found between the first and second name fields. The prerequisite is that the Use name prefix
option has been activated.
The first name, second name and name prefix are also fully merged in the: Salutation in the
document language and Address lines 1-7 mail merge fields.
If the First name and second name fields are used as mail merge fields, then the Name prefix
field is not added automatically. In this case, it is possible that a component of the name is
missing.
This option can only be activated once you have updated the database using the database
wizard.

8.4

Changes to the Windows client

Last used data records
The last data records you opened, are displayed consistently in both the CAS genesisWorld
Windows Client and Web Client. The last 10 data records you opened can be opened directly
from the File menu of the Window Client. In the SmartDesign Web Client, the last 7 data
records you opened are displayed for every app. It doesn't matter if you last opened a data
record with the Web Client or Windows Client.
The last data records you opened with the Windows Client will not appear in the list after
updating, as the Web Client function has been adapted for the Windows Client.
Improved postal code recognition for Austria and Switzerland
We have improved the postal code recognition and address autocompletion functions for
Austria and Switzerland.
Recognition of the new mobile phone dialing codes
Mobile phone dialing code recognition for Germany has been extended to include the new 5figure dialing codes, see http://www.bundesnetzagentur.de.
Importing companies using the address wizard
If you import a company contact using the address wizard, the first name and second name if available - are transferred to the Notes field so that this information is retained.
Scaling calendar views
The daily and weekly views have been optimized to enable the use suitable scaling when
displaying calendar views on high resolution screens.
The Hong Kong country format has been changed

8.5

SmartDesign Web Client news

Version 2.1 of the SmartDesign Web Client has been released to coincide with version x6.0.2 of
CAS genesisWorld.
In this version you will see new notifications that are now available after actions such as saving
or the linking of data records. Link notifications now contain a link to the new data record.

Additionally, Number assignments are now available with the same support as for CAS
genesisWorld Windows Client.
Available user images are now displayed in both the team calendar and the participant selection.
The EBID app is only displayed if the correct access data from the Unternehmensverzeichnis.org
has been entered and the service has been activated.
Creating a document is now always possible with available templates.

8.5.1

Additional languages

In addition to Dutch, English and German, the SmartDesign Web Client is now also available in
French, Italian and Spanish. As far as possible, the browser language will be adopted. However,
users can select their preferred language at logon.

8.5.2

Parent elements

If you are using the Premium Edition of CAS genesisWorld and you have completed the
respective settings in the Management Console, then all of the links with new and existing data
records will be entered as Primary links.
The parent elements are displayed in a new element with the respective hierarchy.

Using the Search button you can edit the parent elements. When you select a level, the search
area for the child levels adapts itself correspondingly. Thus, only suitable projects are found and
displayed for the company you selected. You can also search in an empty hierarchy directly after
a process. The elements situated above are automatically inserted.

8.5.3

Form letter

You can select data records using a new button in the list view. You can highlight one or more
data records with just a click if the button is active. Clicking alone will not open a data records.

Once one or more data records have been highlighted, other buttons for more functions will be
displayed. At the moment, you can create a form letter with addresses.
After clicking the button for the form letter, you can select a template. Afterwards, you can
create a document with links to the selected addresses.

8.6

8.6.1

Mobile apps

Changes to version numbers

The version numbers for the mobile CRM solutions for CAS genesisWorld x6 have been adapted
to suit the number of the main version, so that they now also begin with x6 or 16.

8.6.2

iOS App version x6.2

The following new functions are now available when updating the iOS app to version x6.2.

Assigning individual contacts to a company
Besides a contact person, you can also assign an individual contact to a company. To do this, a
search for companies is carried out in the Company field of an individual contact. The individual
contact is then assigned to this company. Via the Company field, you can also create a new
company. The previous individual contact is transformed in both cases into a company contact
person.

8.6.3

Windows 8 app version x6.0.2

The mobile CRM solution for Windows 8 as of version x6.0.2 is now available in the following 6
languages: Dutch, English, French, German, Italian and Spanish.

8.7

8.7.1

New module functions

Exchange sync

If you change a past appointment (one that has already expired), you will be receive a note from
the system when saving the appointment. The user then decides if the appointment should be
saved by Exchange with or without a notification.

8.7.2

Survey

The new Survey data record type is now available when using the Survey module in conjunction
with Survey online as of the x6.0.2 version. To create and edit surveys you will require a Survey
Manager license.
You can plan your surveys as well as view and notify all your assigned addresses and see which
assigned addresses have already responded in the data record window for a survey. Every survey
can be conducted anonymously so that questionnaires that have been completed will not allow
any addresses to be assigned to them.
On the Addresses tab, you can view and edit the target group.

Besides a search for addresses, you can add one or more distribution lists as target groups to a
survey. In the process, the distribution list addresses are adopted, the survey is not linked with
the distribution list. If new addresses have been added to a distribution list, then the distribution
list has to adopted again. Every address is only added once to a survey.
The Notifications button on the Addresses tab, opens a window in which you can compose a
mail merge addressed to all the highlighted addresses. For this you can use the address and
survey fields taken from the survey as your mail merge fields. The link to the survey is also
available as a mail merge field on your own tab. The Display recipient button opens a window
that contains all the addresses to which this mail merge will be sent.

The list on the Addresses tab of a survey usually displays all the addresses that have been
added. The list can be filtered with non-anonymous surveys: Open just displays addresses which
have not yet responded to the survey. Contact with reply displays addresses which have already
completed the survey.
If users have the necessary right that allows them to import and export data records, then they
can export all or just certain addresses from the survey to Microsoft Excel. The fields exported
this way are defined by the administrator in the Management Console in the Survey area under
Survey online.
All questionnaires that have been completed can be opened in a write-protected view on the
Questionnaires tab of the survey.

Using a new report template for surveys, you can analyze completed surveys anonymously even
if the survey was not conducted anonymously. With selection questions, available answers are
counted and displayed in a diagram. And with questionnaires that include analysis, the points are
displayed and the average of the points for each question calculated. Responses to free text
questions are listed anonymously.

With the Report module you can create report views and/or additional report templates for
surveys. You can integrate associated surveys for addresses via link queries. If questionnaires
have been selected in a report view or report template, with or without survey, the new All
templates option is available. Using this setting, you can integrate all the questionnaires to
associated surveys or data records, independent of the template. For this the standard evaluation
mode is available and not the Questions as fields special mode.

8.7.3

Helpdesk

Mandatory fields in Helpdesk online
With new support requests on the Helpdesk online portal, all the mandatory fields which have
been defined in the Database area of the Management Console for all processes, or for
processes with specific Type and/or Status fields are now checked.
Update proof configuration of Helpdesk online
When updating Helpdesk online, a defined timeout for a session (executionTimeout) is
maintained in the Web.config file.

8.7.4

Report

Initially, the list is always active with report views and report templates, it displays the number of
data records.
The All templates option is now available for questionnaire evaluations. Thus, all the selected
questionnaires from all the templates in the view are displayed.

In the report view properties, the settings for displaying evaluation tables in their own window
are available on the Visualization tab. In addition to the start tab, you can select what tab you
wish to display and, whether or not empty tabs should be hidden automatically and, whether or
not you wish to display the number of data records in the header of each tab.
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9.1

Releases

The Exchange sync add-on module has now been released in connection with the Event
Management add-on module.

9.2

9.2.1

Changes to the Management Console

Displaying private/confidential activities

You can set the display of participants more exactly in confidential and private activities.
Your administrator sets this up in the Management Console > User management > Access
rights. Three options are possible here.
Do you want to display participants and resources?
Or do you only want to display the user who last changed the activity?
Or would you prefer not to display any participants?
The second option was recently added and has the following effects:
If a user places their mouse over a confidential appointment in the team calendar, the person
responsible and the resource(s) are displayed. And while creating or changing an appointment,
an overlap warning occurs for a confidential appointment, then the participants are displayed
with an overlap.
These settings in the Management Console are only possible after the database has been
updated using the database wizard.
You will still be able to use the previous settings if you wish, whereby all the participants are
displayed when holding the mouse over a confidential appointment.

9.2.2

Notification and action service

You have to define fixed and/or variable recipients for notification rules. With variable recipients,
you can set whether you want a notification to be sent to an e-mail address in a specific e-mail
field, for example, E-mail (business 2).
Using the Only send to selected e-mail field setting ensures that a notification is only sent if an
e-mail address has actually been entered in a recipient's e-mail field you have selected. If the
setting is deactivated, another e-mail address is used for sending.

9.3

SmartDesign Web Client news

Dutch Web Client
Besides English and German, the SmartDesign Web Client is now also available in Dutch.

9.4

Changes to the Windows client

Printing labels
When printing labels, the value used for the country is taken from: Output language of
target country in the Settings window > Documents tab > Form letter tab in the Windows
Client.

9.5

Mobile apps

The Mobile apps were also updated for CAS genesisWorld x6.

9.5.1

Android version x6.0.1

Appointments and phone calls are saved on the mobile device over an eight week period as
follows: the last two weeks are cached and the next six weeks. These fields are displayed on the
dashboard.
Any contacts and participants linked to the appointment are also stored locally. This enables
users to access these data records without having to be online, to for example, call a contact who
is linked to an appointment.
Local caching requires that the administrator activate the Mobile apps: make data available
offline option in More rights under User properties in the Management Console.

In addition, users have to activate the Locally saved data (cache) option in the app settings.
The Offline logon setting enables users to logon without being online.
Please note, if this option is active then the user's password is stored locally in an encrypted
area on the user's device.
The Only allow synchronization over WLAN option ensures that synchronization of the
respective data does not occur with a mobile broadband connection, but only with an active
WLAN connection.

10 Version x6.0.0
CAS genesisWorld x6.0.0 has been given a comprehensive facelift. The facelift is based on the
principles of "Flat design". The style is recognizable through its graphically reduced and
minimalistic user interface. This has been applied to both the program window and the CAS
genesisWorld calendar window.

Furthermore, the new Easy Invoice module offers you quick and easy ways to create, save and
manage quotes and invoices.
In addition, users and administrators will benefit from a number of new features that we have
outlined below.

10.1 Releases
Crystal Reports Viewer 2013
Project module
Versions 6.1 and 6.2 of office line are supported.
Report module
Crystal Reports Designer Version 2013 Integration with Typo3-based portals
With the new Typo3 connect you can exchange content between CAS genesisWorld and
Web sites which are based on Typo3. For details and prices please contact CAS Software AG
directly.

10.2 Discontinuation announcements for CAS genesisWorld x6
Microsoft Windows XP
Microsoft Windows 2003
Apache 1.3
The following functions will be discontinued in the x6 main-version release of CAS genesisWorld.
Exceptions relating to existing installations will be communicated separately.
Web access portal
As of x6 the Web access portal will no longer be delivered as a part of the CAS genesisWorld
installation, it is being replaced by the SmartDesign client.
It is possible to install the Web access portal on a CAS genesisWorld x6 server, however, this
requires at least version x5.0.7 of Web access or later.
Smart access portal
The Smart access portal will no longer be available to new customers as of CAS genesisWorld
x6 as it is being replaced by the SmartDesign client.
The Operators in lists were already discontinued for new customers in CAS genesisWorld
version 12, and as of CAS genesisWorld x6 they will no longer be available for existing
customers.
Mobile CRM for BlackBerry module

The existing Mobile CRM for BlackBerry module from BFI and CAS is being replaced by the
new Mobile CRM for BlackBerry solution which is based on the Android app. Thus, the
minimum requirements are now OS10 from RIM.
Changes to the navigator area
The display of icons for Dashboards, Calendar views and E-mail views in the lower pane of
the navigator is no longer available.
The Opportunity analysis function in the Tools menu will no longer be available.
The Search in view function is also being discontinued. Using this function you could search
specific navigator views.
The report templates for Microsoft Word and Microsoft Excel are also being discontinued.
These were already discontinued for new customers in CAS genesisWorld version 12, and as
of CAS genesisWorld x6 they will no longer be available for existing customers.
The CAS genesisWorld form letter will be discontinued as of CAS genesisWorld (x6).
However, you will still be able to create form letters using Microsoft Word.
The Participant list view in the link navigator is no longer available.
Now, in the Survey add-on module, only the simplified layout is available for questionnaires.
And versions 5.0 and 5.1 of Office Line are no longer supported for the Project add-on
module.
Crystal Reports Viewer
You will be required to install the Crystal Reports Viewers 2013, after this CAS genesisWorld
x6 will install automatically. We no longer support the use of older viewers such as XI, 2008 or
2011.

10.3 Changes to the data structure
Database field functionality has been extended internally, so that now the field value displayed in
all views, data records and clients is identical. So, for example, date fields (such as those denoting
the end of an opportunity) are displayed in CAS genesisWorld lists daily.
In one of the next software updates, the administrator will be able to define respective
properties for own fields in the Management Console.
The Management Console is installed automatically when installing the CAS genesisWorld
Windows Client without an application server.
Please note the change to the installation described here. The Management Console can no
longer be selected separately, but is instead distributed via the Client installation.
You will only see the Management Console listed in the Microsoft Windows Start menu if the
CAS genesisWorld server is also installed.

Likewise, when installing via the update service, both the Windows Client and the Management
Console are installed on the user’s PC.

10.4 Changes to the Server Manager
The SmartSearch service has been added to the SmartDesign Web client.
Load Balancing is now available in the Standard Edition free of charge without a license.

10.5 Changes to the database wizard
New icons now give the database wizard a contemporary look and feel.

If a new database is created, then you will no longer be able to create a demo database with CAS
genesisWorld x6 using the database wizard. We will soon be making backups of demo databases
available on the Partner Portal.
When naming databases, the software checks for valid characters.
In the beginning, the administrator of a new database receives other rights: Edit/execute
action, Display change log, Edit change log, SmartDesign. Initially, the following actions
are also permitted: creating and editing of own and public view formats.

10.6 Changes to the Management Console
New security settings
Administrators profit from extended options for protecting company data.

In the User management area > Security settings you can define if and when a user has to
re-enter their CAS genesisWorld password.
The actions are related to the expanded rights for the export of data.
Please note, you can only activate the settings for re-entering your password if all users can
also logon to CAS genesisWorld with the password.
If the Only allow Windows authentication option is active for at least one user, a note opens
when activating the security settings. If you continue with the activation, the Only allow
Windows authentication option is reset for all users automatically.
No input assistance options for the Form of address field
Values for the Form of address field originate from a file which is managed by the
administrator and kept on the application server. Thus, you can no longer generate input
assistance options for the Form of address field.

10.7 Changes to the Windows Client
On starting CAS genesisWorld, you will see the revised and slender new look user interface.

10.7.1 Facelift
The CAS genesisWorld program window has been completely revised with a view to making the
user experience more pleasant for those getting started with CAS genesisWorld and for existing
users.
The main changes are as follows:
Lists

Lists now use the larger Segoe UI font as standard and the line spacing has been increased.
Likewise, the background color scheme has been changed in many places and lists have been
adapted.

Toolbars
The toolbar has been tidied up and labels have been standardized. The scroll bar for an area
such as lists, is displayed dynamically when your mouse pointer is in the area.
Scrolling with the mouse wheel has an immediate effect on the area currently occupied by
your cursor. Thus, you no longer need to specifically focus on a given area.
Program navigator
We have removed the display of icons for Dashboards, Calendar views and E-mail views in
the lower pane of the navigator.
Naming conventions for views and folders now use ellipsis (...) if the current screen width of
the program navigator is not sufficient. The full name is displayed when the program
navigator is made wider/resized as is usually the case.
Calendar
The new design will undo any color scheme settings you might have made for the calendar,
this is to ensure that the calendar looks the same for all users. However, you will still be able
to set custom colors for appointments, background colors for days and so on.
The color schemes and appointment icons have been completely removed from the calendar.
However, the icons for holidays and out of office will still be displayed.
Consequently, you will find the team calendar is now easier to use as the names of all the
selected users are displayed above the calendar area. The appointments and activities of a
specific user can now be removed with just one click on the remove x button.
Tooltips have also been redesigned in all the calendar views.

Public holidays are still characterized by red text. The name of the public holiday(s) is
displayed when your mouse pointer is over the small calendar icon next to the date.
Report templates
Numerous report templates are now available in the new design.
Personal settings
You can now select whether you want to permanently hide or display the menu bar on the
Working environment tab in the Settings window. If the menu bar has been hidden, then
you will see an arrow displayed on the right-hand side of your program window. Clicking the
arrow displays the menu bar.
You can still customize list colors in the Settings window.

10.7.2 Addresses
Addresses now contain two new fields.

Gender field
The Gender field for individual contacts and contact persons can be filled out automatically or
manually. When you enter a first name, both the Gender and Form of address fields are
completed.
The following rules apply to suggestions:

The first name can be clearly allocated to either a man or a woman.
Male or female is then entered into the Gender field.
The suitable Form of address is entered according to the Country in the address.
The automatic inputs can of course be overwritten by the user.
If a first name is saved that is not clearly identifiable as male or female, then the Gender and
Form of address fields are not completed.
Input assistance options are no longer available for the Form of address field, because the
form of address is completed with the help of a file created by the administrator, this file
contains first names and is extendable.
In addition, the Salutation field is also completed automatically when the addressee's second
name is entered.
The following rules apply to suggestions:
The content of the Salutation field is determined by any presets you may have entered for
the Country and Gender fields.
Default values are available for the following countries in standard edition: Austria, Germany,
Hungary, Italy, Switzerland (German values), Spain, the United States, the United Kingdom, the
Netherlands, Turkey, Romania and the Czech Republic.
The fields are only completed automatically if no values have been inserted. If users change the
values in the First name, Second name or Gender fields, then new presets are entered - if the
current values are identical to the values that were originally suggested.
The Gender field can remain empty or you can select Other as the field value, for example, in
the case of a family.
When creating form letters and mail merges, the Gender field is included, if the Salutation in
document language form letter field is being used.
For example
You want to write a form letter to a group of international addressees, the letter will be
composed in English. For the salutation you are going to use the Salutation in document
language form letter field. When composing the letter, you want the salutation for each
addressee to reflect the Gender field, content should be in English.
The Salutation in document language function is also used as the form letter field when the
Salutation field is being used in the Microsoft Word document, but where the Salutation field
has not been completed for an address.
The address check, checks and informs you of inconsistencies between the following fields: Form
of address, Gender and Salutation with respect to the Country field.
If you have multiple foreign addresses for a single address data record then the address check
function is limited to just inconsistencies between the form of address, salutation and gender.

The Insert salutation automatically option is no longer available on the Documents/Form
letter tab in the Settings window, this function is now defunct due to the new automatic
defaults.
Note for the administrator
The defaults for the form of address or salutation of an address are stored in the
AddressTerm.ini file in the ...\CAS-Software\Server\AddressCheck\ folder.

Supporting multiple official languages for one country
You can still complete Form of address and Salutation fields automatically even for countries
that have more than one official language.
Besides the Country and Gender fields, an additional criterion is used. The following example
illustrates how the Preferred language field is used as another criteria.
Add the AddressTermPreferred.ini file to the ..\\AddressCheck folder on the application server.
[Description]
PreferredValueFieldName=PREFERREDLANGUAGE
[CH]
Deutsch-m=Herrn
Deutsch-w=Frau
Deutsch-mw=Familie
Deutsch-letterM=Sehr geehrter Herr
Deutsch-letterW=Sehr geehrte Frau
Deutsch-letterMW=Sehr geehrte Damen und Herren
Italienisch-m=Signor
Italienisch-w=Signora
Italienisch-letterM=Gentile Signor
Italienisch-letterW=Gentile Signora
Italienisch-letterMW=Egregi signori
…
PreferredValueFieldName refers to the physical field name of the third criteria.
[CH] is the ISO abbreviation of a country for which there should be multilingual support. You
have to create a block for each official language that is supported,
German is the physical value from the PreferredValueFieldName field and -m is the ID for the
male gender.
You can create the file for any country and values. If the selected value in the third address
criterion is not stored in the additional file, then the default value is used from the
AddressTerm.ini file.

Tax ID field
On the Details tab in an address data record, you will see the Tax ID field displayed.

10.7.3 Unternehmensverzeichnis.org integration
You can now display the EBID number, stored in an additional field, as a column in address lists.
You cannot edit this number as the value comes directly from an automatic service and is
inserted into the field.

You can connect addresses in CAS genesisWorld with other address services, for example,
bedirect and with the Unternehmensverzeichnis. The address check then uses the additional
information provided by the various services to check your addresses. If you wish, you can
synchronize your data with the Unternehmensverzeichnis manually in the open address data
record.
The application server that has been set for service in the Management Console is now
independent of the georeferencing application server. Thus, both services use different
application servers.

10.7.4 More functions
Timezone add-on module
The Timezone add-on module is now available on request to new customers.

The last login is displayed on the status bar.
After logging on, the CAS genesisWorld status bar displays the last client the user logged on
with and at what time. This information disappears as soon as a view is opened.
An overview of the last logon opens in the ? menu under Info when you click on the user
name.
Printing e-mails from a list
In the e-mail list view, if you highlight a single e-mail it will be printed out. Not doing so,
results in a list being printed.
Keyboard combinations for Insert as Text
Text from the clipboard can be inserted into notes by using the following keyboard
combination: Ctrl + Shift + V.
Changes to button names
Follow-up has been changed to Create task.
Selecting individual items
In all lists of items you can now highlight individual items, for example, product items in
opportunities, order items in projects and receipt items in receipts. This enables you to
produce offers or projects with a subset of the recorded items.
Products with different currency
If the currency for an opportunity or a project has been defined, you can still accept products
with different currencies as product items or order items. When adopting a product that has a
different currency, all none-price sensitive information is adopted from the product. Existing
price sensitive information for the item is reset.

10.8 SmartSearch
SmartSearch offers a new type of search for CAS genesisWorld data.

SmartSearch is, for the time being, only available in the SmartDesign Web client. An
integration with the Windows Client and other mobile CRM solutions will follow soon.
For this search, the data is classified according to a number of criteria such as actuality of the
data record, participants or links according to their relevance, and then earmarked in an index.
This index can then be searched quickly and delivers suitable hits even with large quantities of
data.
The first version of SmartSearch has been restricted to the following data record types:
addresses, appointments and documents. Future software updates will add additional data
record types and configuration options, so that for example, you can include your own fields and
data record types. Document content is, as yet, not included in the search.

10.8.1 Indexed fields
The following fields are relevant to the index and can be searched for the supported data record
types (addresses, appointments and documents):
Data record type

Indexed fields

ADDRESS

Name, ChristianName, CompName, CompName2, Town1-3,
MailFieldStr1-5

DOCUMENT

Keyword, gwFileType

APPOINTMENT

Keyword

10.8.2 Configuration
All configurations are carried out in the Server Manager and in the Management Console.

Server Manager
The SmartSearch functionality is activated on the Services tab of the CAS Java Services.
The default value for the port should only be changed if the port is already being used on your
system. The port is required for internal purposes on the application server and, subsequently,
should not be accessible to external parties.

Management Console
In the Database area under General on the SmartSearch tab you can create the index and
activate the search.
The indexing is always active so that all the changes in CAS genesisWorld are also included in the
index.
With Create new index a new index is built. This can take several minutes. During this time the
searching is restricted.
You have to include all the application servers with the SmartSearch server that are used to
connect SmartSearch with the SmartDesign Web client. If the SmartDesign Web client is only
available via the application server, then this is the only one you will have to enter.

10.9 New features in the SmartDesign Web client
Version 2.0 of the SmartDesign Web client has been released to coincide with the release of
version x6 of CAS genesisWorld.
We have significantly extended the basic functionality and process security. Thus, the type, status
and mandatory fields are now available as in the Windows Client as well as the same field
formatting, for example, dates without times for specific date fields. The new Gender field is
available with contact persons and individual contacts in the Web client. You can now edit
Product items when editing opportunities.

10.9.1 SmartSearch
We will be offering SmartSearch functionality in our new SmartSearch app. Search terms entered
into the SmartSearch field are used to search addresses, appointments and documents. The
matching strings are highlighted in the search results.
In this first version of SmartSearch, the 5 best hits per supported data record type are displayed.
A maximum of 15 results each with 5 addresses, appointments and documents are also found.

10.9.2 Links
You can link existing data records to either the open data record or to a new data record you
have not yet created. Using the Link with... button the data record type is selected first of all.
Afterwards, a window opens containing the last data records of this data record type you used
and a search.
You enter the link using the button for a new data record.
With this version of SmartDesign internal links are also supported as well as adding and linking a
customer to an opportunity.
Primary links will be supported in a future software update.

10.9.3 Creating documents with templates
From an open contact, you can access existing document templates with the Create document
function. With this you can create a letter and add mail merge fields using the CAS Word add-in.
The contact data is then inserted as usual in the-mail merge fields.
Creating such a document is currently only possible with one recipient.

10.9.4 Displaying the last logon
After logging on, you will see a message displayed at the top of the screen informing you of the
last logon. This message is hidden after 5 seconds.

10.10

Web access portal

The Web access portal will no longer be included. Partners and customers can still operate the
portal on the basis of CAS genesisWorld x5 but using CAS genesisWorld x6. To do this you will
need to have installed Web access based on CAS genesisWorld x5.0.7 or later.

10.11

New features in the modules

10.11.1

Easy Invoice

Easy Invoice is now available with the current version of CAS genesisWorld.
Easy Invoice enables you to create easy and professional receipts in CAS genesisWorld. The
standard version will already include the following receipt types: Offer, Order, Invoice,
Credit note and Cancellation.
The module allows you to create receipts via addresses and opportunities. If the Project
module is being used, you can use Easy Invoice to create project invoices for time records,
expenses and external services.
For more information please see the Easy Invoice user guide.
The module is not an ERP solution, it is specifically restricted to the basic functions.

10.11.2

Event Management

A number of fields have been discontinued
The following fields are no longer available with new installations for the Registration data
record type: Participation, Note and Comment.
These fields will no longer be displayed in existing installations, however, they are still there
and can still be displayed in the list.
None-personalized registration link
On the Registration tab for an Event, you can copy a URL that leads you to Website. If the
URL or link is published - for example on another Internet page - interested parties can
register if they wish. This change eliminates the need for a mail merge that uses personalized
links to link users back to the page containing the registration formula.
Event online is multilingual capable
Invitations can now be sent in multiple languages. So for example, when sending German mail
merges to German recipients, or English mail merges to English recipients, Event online opens
in the respective language being used, in this case either German or English. The Document
language field of the-mail merge is included.
New Description field
In future, the new Description field will replace the Notes field in Event Online. Thus, you can
enter the official description of the event directly in the Description field, whereas the Notes
field is reserved for internal CAS genesisWorld users.
When updating to CAS genesisWorld x6, the value from the Notes field is copied to the
Description field.
Event online currently still uses the Notes field during publishing for the official description,
this will be changed in a later software update.

10.11.3

Form Designer

New formatting option
We have a new Default formatting in the option in the Format dropdown list. This option is
set automatically if a new field is inserted with the Form Designer.
The format is not changed by the software update, if a specific option is already set.

Additional tabs with Easy Invoice
If you are using the Easy Invoice module, you will be offered more address tabs in the Form
Designer.

10.11.4

Geomarketing and Sales pro

You can display leads on maps if an address has been allocated. To do this, you have to have
completed the georeferencing for address.

10.11.5

Helpdesk

Calculating service days
When calculating service days with new installations, only the hours are saved as a value. You
will no longer be able to save minutes and days. This prevents inconsistencies in conversion
calculations where there is a difference in the length of days and service days.

10.11.6

Load balancing

The options for load balancing when running multiple application servers for CAS genesisWorld
servers are now included in the standard x6 version of CAS genesisWorld.

10.11.7

Project

User sensitive resource plan for new databases

When using the resource plan data record type with new databases the User sensitive option
is active.
New Currency field for price
When working with prices, users will now see a currency field displayed in read-only mode in
the data record window. When creating a price, the basic currency is set as the preset value as
long as a product has not been selected. If a product has been allocated, then the product
currency is adopted.
Thus, the currency can also be displayed in a price list.

New Reference mark field on the Details tab for projects
The Reference mark field can be used freely.
If you are also using the Easy Invoice module, then the field is automatically included when
creating a project receipt.
New Billing type field
Your preferred Billing variant is preset for a product with the new Billing type field.
The following options are now available: One item (lump sum), One item for each hourly
rate (days) and One item for each hourly rate (hours). The Report module is used to
analyze this field when preparing for billing.

10.11.8

Survey

The text of an associated data record is saved to the questionnaire additional information field,
as already indicated in the questionnaire.
For new questionnaire templates, the compact layout is used automatically as no other layout
can be selected. When creating a questionniare template without a compact layout, this option
continues to be displayed.

10.12

Mobile apps

Mobile Apps - (mobile Apps or mobile CRM solutions) - are now included in the Mobility
module. The Mobile Apps as a standalone module is no longer available.

10.12.1

iOS-app version 3.4

Update 3.4 for the iOS app now includes a new user function.

Creating contact partners from a company
New contact partners can be created from a company data record. In the process, the settings
for synchronous field values in the Management Console are included.

10.12.1

BlackBerry-app version 3.2

The BlackBerry OS 10 and CAS genesisWorld x5 apps are now available for immediate download
from BlackBerry App World.
In terms of functionality, this version corresponds to the Android 3.2 app and CAS genesisWorld
x5.
Please note that we do not support either the PlayBook or Porsche Design from BlackBerry
mobile devices. Operation requires BlackBerry OS 10.2.0 or later.

